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2 Microsoft Office 2010 Common Features 



Many of the applications in the Microsoft Office 2007 & 2010 

systems have a new appearance.  

The Ribbon user interface feature replaces the current system of 

layered menus, toolbars, and task panes 

A simpler system of interfaces optimized for efficiency and 

discoverability.  

The Ribbon interface provides 

 improved context menus 

ScreenTips 

Mini toolbar 

Keyboard shortcuts that improve user efficiency and productivity.   

Existing Office 2003 users should be able to quickly master 

the Office 2007 & 2010 navigation system.   
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This new user interface is tightly integrated into all Office 2010 

applications. 

 

Creates common navigation procedures 

 

With the exception of special purpose functions, all buttons 

and groups are the same on the corresponding ribbon tab in 

other Office 2010 applications. 
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1. File Tab: Contains the commands that affect the entire document 
or program. The Open, Save, Save As, Print, Close and Exit 
commands are here.   This group of functions is called 
“Backstage.” 

 

2. Quick Access Toolbar: Is used to access some of the most 
frequently-used commands. These commands include Save, 
Undo, and Redo.  

 

3. Ribbon: Replaces most of the Menu bar items and the toolbars 
used in Office 2010.  

 

4. View & Zoom Slider: Tools replace many of the View menu items.  

 

5. Mini Toolbar:  Only appears when text has been selected in the 
document. This toolbar contains the frequently-used formatting 
commands such as Bold, and Italics. 
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The Microsoft Office Backstage is part of the Fluent User 
Interface  and a companion feature to the ribbon.  

The Backstage view, which can be accessed from the File 

Tab, helps you find frequently used features for managing 

your Word documentation files.  

The File tab replaces the Microsoft Office Button and File 

menu that were used in earlier release of Microsoft Office. 

The Backstage view is used to manage files and the data 

about the files 

creating and saving files,  

setting file options. 
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If Open is selected, the Open dialog box is displayed.  

Navigate to the appropriate disk and folder, and then double-click 
on the name of the file to open.  

If a document is selected from the Recent Documents list, the 
document opens directly in a window within the Office 2010 
application.  

 

To Save, Print, or Close a document, click on the Office Button 
then choose the appropriate option from the list.  

 

To exit from an application, click on the window’s red X in the 
application’s title bar or click the Office Button then select the 
Exit  button.  

 

In the Recent Documents List, Office 2010 Can list up to the last 
50 documents that were opened with the present application.   

The names in the document list change over time as various documents 
are opened and closed.  

 If it is desired to permanently display the name of a frequently used 
document, click in the document’s placeholder.   
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The Quick Access Toolbar is a collection of icons for 

frequently-used commands.  

By default, the Save, Undo and Redo icons are displayed.  

This toolbar is customizable, by three different methods, so that 

icons may be added for frequently used commands.  

 

The Quick Access Toolbar may be displayed either above or 

below the Ribbon.   

Moving the toolbar to the bottom of the Ribbon may take up 

more room on the window but it will be able to display a larger 

number of custom commands. 
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Click on the Customize arrow to display the list of toolbar 

customization options 
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Click on the More Commands option shown in figure 4.  

The application Options dialog box, figure 6, will be displayed.   

Select the drop-down arrow to Choose Commands From:  then 

click and add the commands desired to be included in the 

Quick Access toolbar. 

 

Figure 6 

Figure 4 
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The third method of adding commands to the Quick Access toolbar is to right 

click a command on the Ribbon. From the options that appear, select Add to 
Quick Access Toolbar. 

 

To remove a command from the Quick Access toolbar, right-click on the 

command and select Remove from Quick Access toolbar. 
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The Ribbon is the most salient feature of Microsoft Office 
2010.  

It replaces the Menu bar and toolbars that were used in Office 2003.  

The Ribbon is divided into command tabs that correspond to 
the major functional areas of Office 2010.  

Each command tab is analogous to an Office 2003 toolbar and 
includes tools 

Links related to actions that are performed frequently in WORD, Excel, 
PowerPoint, or Access.   

Actions such as cut, copy and paste, font changes, paragraph 
formatting, alignment, find and replace, and themes are on the Home 
command tab.  
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Each tab of an Office 2010 Ribbon is segregated into major 

functional subdivisions called Groups. 

 

Each Group is sub-divided into corresponding functions many 

of which include drop-down arrows that will display additional 

functions or options. 
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The Ribbon takes up a large area of the application 

window. Hiding the Ribbon will enable the Office 2010 

application to display its work on a larger portion of the 

window.  

To temporarily hide the ribbon, double-click on the active tab of the 

Ribbon.  

 Alternatively, press CTRL + F1 to hide the Ribbon.  

To display the hidden Ribbon for one action, click once 

on any tab.  

After the one action is completed, the Ribbon will hide again.  

To display the hidden Ribbon until you choose to hide it 

again, double-click on any tab. 

Alternatively, press CTRL + F1 to display the Ribbon. 
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The Command tabs for Word are Home, Insert, Page Layout, 

References, Mailings, Review and View.  

Each tab represents a category of actions that is divided into 

groups.  

The Home, Insert, Review and View command tabs are common to Word, Excel, 

and PowerPoint.  

Each program has additional command tabs that are specialized for the type of 

document that are created in that program.  

On the Home command tab in Word, the first group of actions 

is cut, copy, paste, the format painter and the clipboard.  

The other groups of actions on the Home command tab are Font, Paragraph, 

Styles and Editing.  
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In earlier versions of Office,  a Tool Tip was displayed when 

the mouse pointer was placed over a tool button. 

 Usually this tip was the name of the tool, such as Bold or Font 

Color.  

In Office 2010, the tool tips have been expanded and are 

called Super Tool Tips.  

Super Tool Tips display the name of the tool as well as a 

description of its features.  

In addition, the Office keyboard shortcut is frequently displayed 

with the tool tip dialog. For example, pointing to the Bullets tool 

displays the following tip: 
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In the Ribbon, the dialog boxes are accessed by clicking on a 
Dialog Box Launcher icon in the lower right-hand corner of the 
Group title as shown below. 

 

Dialog Box Launchers are available for some but not all of the 
action groups on the Ribbon.  

When selected a dialog box is displayed that provides additional, 
detailed options for the functions within a group.   

Most of the dialog boxes are identical to those found in Office 2003. 
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When a specific object is selected, such as a text box, graph, 
or picture, an additional tab will appear in the Ribbon.  

This tab is called a Contextual Tab, because it contains the commands 
related to the Specific work that you are doing.  

This tab displays the frequently-used commands for working with the 
selected object.  

Click on the Contextual Tab to display its commands and tools.  

Contextual Tabs are displayed above the Command Tabs only 
when an object is selected.  

There are many Contextual Tabs, but only the one related to 
the selected object is displayed.  
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In Office 2010 when it was desired to format text or modify an 

object such as a table, the text or object would be selected, 

the Office application would display a dialog box, then options 

could be chosen and applied to the object.  

If the options were undesirable, the dialog box would be re-displayed 

and make different options were selected and applied until the desired 

results were achieved.  

Office 2010 has significantly improved the process of 

modifying the properties of text or an object.  

The Ribbon contains Galleries.  These are sets of thumbnail graphics 

that display the result of applying a formatting command.  

The Galleries use Live Preview to display the results of choosing a 

particular item in a Gallery without having to first apply the choice.  
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The status bar, located at the bottom of the window, displays 

the View tools and the Document Zoom Slider as shown below.  

These tools provide ways to change the look of the work 

window.  

Each Office program has its own set of views.  

The Zoom Slider is available in Word, Excel and PowerPoint.  

To increase the magnification of the view, click on the PLUS 

Sign tool or use the mouse to drag the slider to the right.  

To decrease the magnification of the view, click on the MINUS 

Sign tool or use the mouse to drag the slider to the left.  
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When working with a document, one of the most common tasks is to 

format text. In Office 2010, the Mini Toolbar appears when text or a 

cell within a table is selected. This toolbar is faded in appearance, as 

shown below, until the mouse pointer is placed over it. 

 

When When the mouse pointer is placed over the toolbar, it fills in and 

is available to use. 
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Documents saved in Word, Excel and PowerPoint in Office 2010 are 

saved in a new file formats.  The documents have the following file-name 

extensions: 

Documents Office 2010 files cannot be opened directly in an Office 2003 
program.  

 

In order to open a Word, Excel or PowerPoint 2010 file in an Office 2003 
program, a special add-in program called “Microsoft Office 2010 Compatibility 
Pack must be installed on the computer where the file is being opened.  

 

The compatibility pack is available as a free download from 
www.microsoft.com .   

 

When an Office 2010 file from Word, Excel or PowerPoint is opened in Office 
2003, a conversion message is displayed in the status bar. 
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http://www.microsoft.com/


When an Office 2010 file is converted by the add-in program 

and opened in Office 2003 the new 2010 functionality will not 

be available.  

 

A message is displayed after the document is converted from 

2010 format to 2003 format.   

 

Office 2010 programs, however, can open files saved in Office 

2003. No extra step is needed.  

 

When a file with an Office 2003 format is opened in Office 

2010, the file is opened in Compatibility Mode as a precaution.   

 

When the file is saved, it is saved in the Office 2003 format to 

maintain compatibility.  
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Documents can be saved in Office 2003 format, however, 

rather than the new 2010 format.  Select the File Tab, choose 

Save As, and then choose Word 97-2003 Document. 
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Several color schemes can be applied to Office 2010 in order to make 

the appearance of the application windows more visually appealing.  

The color scheme that you select will carry over to all Office 

programs.   

 In order to select a color scheme click the File tab in any Office 
application then select the Options button. 

The application’s Options box will be displayed.  

Confirm that the Popular button is selected in the Options box  

Select the desired color scheme as shown below, then select OK. 
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Many Microsoft Office 2010 functions use views or operation 

windows to present information, show results, or conduct a dialogue.  

Major parts of  a typical operation window. 

 
 Title Bar 

Minimize 
Maximize 

Close 

Scroll Arrow 

Vertical Scroll Bar 

Scroll Box 

Scroll 

Box 

Diagonal 

Resize 

Arrow 

Status 

Bar 

Operation 

Window Display 

area 

Horizontal Resize 

Arrow 

Vertical 

Resize 

Arrow 
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Resizing arrows appear when the mouse cursor is placed   

over the border or anchor of  an object.   

The arrows indicate that the object’s size or location can be 
changed.   

An object may be a text box, picture, clipart, drawing, etc 

Moves the entire object without resizing. 

Expands or contracts the  object horizontally 

Expands or contracts the  object vertically 

Expands or contracts the  object diagonally.  

Keeps the object in proportion. 

•Place anywhere on a border or marquee 

•Place on an anchor 

•Place on an anchor 

•Place on an anchor 



Activity: 
Explore an Office 2010 Window 

Microsoft Office 2010 Common Features 
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Single Blue Chevron 

Double Blue Chevron 

Toolbar  Triangle 

Right Point Black Triangle 

Down Point Black Triangle 

These icons indicate that additional menus or 

additional selections are available.  Left click the icon 

to display the additional selections. 



Text can be selected in order to:  
Cut, Copy, or Delete 

Change the format 

 Color 

 Font 

 Size 

Text can be selected in order to: 

Place the mouse pointer at the beginning of the word or series of words that are to be 

selected. 

The mouse pointer will be displayed as a large “ I” called the “ I -Bar” 

 If the mouse pointer arrow does not change into the I-Bar, press the left mouse button 

Press and hold down the Left mouse button then move the I-Bar over the text to be selected. 

After selecting the text, release the left mouse button.  The text will remain highlighted. 

 

Right-Click to display the menu to cut, copy, paste,  delete, or format. 
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Activity : 
Select & Highlight Text 
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Step 1: Start the word processing program 

 

Step 2: Type sample text into the Microsoft Word 

Document 

 

Step 3: Select & Highlight text 

Copy the text 

Move the text to another location 

 

Step 4: Select & Highlight then Change Text Format 
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Step 1: Start the word processing program 

Left-click the Start button to display the Start Menu 

Select All Programs from the Start Menu to show the computer program list 

On the Program List, left-click Microsoft Office 

Select Microsoft Office Word from the list of Microsoft Office Programs 
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Step 2: Type sample text into the Microsoft Word Document 

Type the following text: 

 

 

 

 

At the top left-hand corner of the Microsoft Word window, left-

click on File then select Save. 

Save  the document as Exercise 1. 
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Step 3: Select & Highlight text 

Select and highlight the first sentence of the paragraph you just 

typed. 

 

 

 

 

Right-click the mouse to display the menu and left-click the Copy 

option. 

Place the mouse pointer at the end of the second paragraph.   

Press the Enter key twice 

Right-click the mouse to display the menu and left-click the 

Paste option. 
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The more you use Windows XP and Windows-based applications like Microsoft Office or Corel Office Suite, the 

greater the probability that you will want two or more windows open simultaneously.  This feature enables you to 

copy and paste form one window to another or ready from one while working in another.  The following figure 

shows three windows simultaneously displayed on the desktop. 

 

 

1. Moving Multiple Windows Around the Desktop:  Left-click on a window’s title bar, hold the mouse button down,  then drag the 
window where you want it. 

 

 

2. Expand or Resize a Window:  Click on the Maximize button or move the resize arrows on the Window’s border. 

 

 

3. Move Two or More Windows Next to Each Other:   Right click anywhere on a blank spot of the desktop taskbar.  The Windows 
Management dialogue box will be displayed.  The options include Tile Windows Vertically and Tile Windows Horizontally. 
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Creating a New File (Ctrl l+ N) 

 

Opening an Existing File (Ctrl + O) 

 

Saving Your Work (Ctrl +  S) 

 

Printing Your Work (Ctrl + P) 

 

Cut (Ctrl + X) 

 

Copy (Ctrl + C) 

 

 

Paste (Ctrl + V) 

 

Finding a Word or Phrase (Ctrl +F) 

 

Check Spelling (F7) 

 

Undo (Ctrl + Z) 

 

Redo (Ctrl + Y) 
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